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Chapter 1 

 

Introduction 
This guide is a troubleshooting resource for problems you may encounter 
when using Pro Tools. It covers the most common issues and errors that 
you might encounter (even if you are an experienced user), as well as 
provides information on common Pro Tools errors and why they occur. 
 
We hope that you will find this guide useful should you experience 
problems in Pro Tools, but it is by no means all encompassing. If you are 
still having trouble after reviewing this guide and the other documentation 
provided with your Pro Tools system, please visit our website at 
http://www.digidesign.com. Our online Answerbase and support forums are 
constantly being updated with the latest compatibility information and 
troubleshooting information. If necessary, you can also contact our Tech 
Support department (see Support Information). 
 

Compatibility Information 
 
Before installing a Digidesign  product, configuring a computer for Pro 

Tools, or upgrading your system, it is very important to check system 
compatibility. A comprehensive list of supported systems and compatibility 
information can be found on our website at 
http://www.digidesign.com/index.cfm?navid=54&itemid=23954. 
 
If your computer or system configuration is not specifically listed on our 
support page, then we have not tested it with Pro Tools and cannot 
guarantee its performance. For some errors, upgrading to a supported 
system may be the only solution. Our Tech Support department cannot 
fully troubleshoot an unsupported system, as we will have no empirical 
data on that system's performance. 
 
Please keep in mind that technology changes quickly. If you upgrade to a 
new system configuration, there is a chance it will not work with the current 
version of Pro Tools. Digidesign tests and qualifies new operating systems, 
processors, chipsets, and other technology changes before supporting 
them. If a new release of Pro Tools is required for compatibility, it will be 
available on our website at http://www.digidesign.com. 
 
Use a Digidesign-qualified computer to achieve maximum performance 
and track count. When considering a new computer purchase or upgrade, 
it is always best to choose a system that has specifically been qualified by 
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Digidesign. The on-line list of minimum system requirements should give 
you a good idea where to start when building a custom computer. 
 

Support Information 

 
There is a limited period for free technical phone support for Digidesign 
products. The length of this period depends on the system, software, or 
upgrade purchased (we do not offer phone support for demo software). 
This complimentary phone support period is only available to registered 
customers who are the original purchaser of the product. The free support 
period is based on the date of purchase, not the date of registration. To 
determine the support period of your product, visit the Support section of 
our website at http://www.digidesign.com/reg. 
 
To register your product online, complete the instructions on the Digidesign 
Registration Information Card included with your product. If you do not 
have an Internet connection, are missing the card, or purchased your 
product second-hand, please contact Customer Service for assistance.  
 
Once the complimentary phone support period for your product has 
passed, you can still receive technical support from Digidesign:  
• By completing the e-mail form on our website at 

http://www.digidesign.com/tsr. 
• By purchasing a one-year Support Assurance Contract. For Telesales 

contact info, see the Support Assurance section of our website at  
http://www.digidesign.com/index.cfm?navid=54&itemid=4930, or visit 
our online store at http://www.avidstore.com. 

• By paying a per-incident fee on our Pro Access Line. For pricing and 
contact information, see the Support > Contact section of our website at  
http://www.digidesign.com/contact. 

  

Performance Considerations 
 
To increase the performance of Pro Tools, it is sometimes necessary to 
disable certain devices or processes that take up valuable system 
resources from your computer. This is especially important for Pro Tools 
LE and Pro Tools M-Powered systems, since these systems rely entirely 
on the host CPU to perform audio processing tasks. Disabling certain 
items can also prevent conflicts with Pro Tools operation.  
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See the Getting Started Guide for your system and refer to the 
configuration information for your OS (Windows XP or Mac OSX). All Pro 
Tools systems include a printed Getting Started Guide, as well as an 
electronic PDF that is automatically installed to your Digidesign/ 
Documentation folder. This folder contains many other useful guides. 
Additional information can be found in the Support FAQ found under the 
Help menu of Pro Tools and also available on the Digidesign website at  
http://www.digidesign.com/support/faq. 
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Chapter 2 

Hard Drive Considerations 
 
In order to achieve maximum performance and the highest possible track 
count with Pro Tools, a supported hard drive configuration is necessary. 
This section covers hard drive configuration, including:  

• Internal and external audio drives 
• FireWire PCI and PCMCIA cards 
• SCSI adapters 

 
Hard Drive Recording Information 
 
Recording to your system drive is not recommended. Think about your 
hard drive as a record player, where the spinning vinyl is storing your 
information and the tone arm is responsible for reading and writing data. 
Your operating system and applications are constantly asking the tone arm 
to search and gather the information necessary to keep them running. This 
data is usually scattered around different areas of the platter (disk).  
 
By recording to your system drive, the read-and-write head (the “tone arm” 
to follow the record player metaphor) has to move across the disk to write 
audio files. Audio files have a much higher bandwidth than your typical 
system files, and therefore require more time to read and write. This extra 
time can cause interruptions with normal system operation, and can result 
in Pro Tools reporting DAE errors (–9093, –9073, –6086, and others).  
 
By simply adding a dedicated audio drive to your system, you can alleviate 
many such errors. For a complete list of supported hard drive 
configurations, please visit our website: http://www.digidesign.com/support. 
 
Approximate Storage Consumption (Megabytes per Minute per Track) 
 
To avoid running out of disk space and prevent drive-related errors when 
recording, use the following information to approximate drive consumption 
by the number of tracks in your Pro Tools session and by the session bit-
depth and sample rate. 
  
16-Bit Audio Files: 

• 5 MB per minute per track at 44.1 kHz sample rate 
• 5.5 MB per minute per track at 48 kHz sample rate 
• 11 MB per minute per track at 96 kHz sample rate 
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24-Bit Audio Files: 
• 7.5 MB per minute per track @ 44.1 kHz sample rate 
• 8 MB per minute per track @ 48 kHz sample rate 
• 16 MB per minute per track @ 96 kHz sample rate 

 
Additional Notes: 

• Pro Tools has a single audio file size limit of 2048 MB. This equates 
to about 4.5 hours at 24-bit, 44.1 kHz. 

• High Speed Drives (above 7200 RPM) require a manufacturer-
approved enclosure to ensure proper heat dissipation, which is 
required for sustained drive reliability. 

 

Internal Audio Hard Drive Considerations 
 
If you are using an internally mounted, dedicated audio hard drive, please 
review the following: 

• IDE/ATA or Serial ATA (SATA) drives are supported by Digidesign 
(non-RAID configurations only) 

• Spindle speed of 7200 RPM or higher required 
• Less than 10 milliseconds of Seek Time required 
• DMA must be enabled for Windows formatted drives (PIO mode not 

supported—more on this in Chapter 4). 

• SCSI drives require a host bus adapter card (all SCSI configurations 
must be properly terminated). For more information on SCSI 
configurations, see the Getting Started Guide supplied with your 
product (either printed or PDF). 

 
SCSI Drives—Approximate Track Count 
 
The following test results are with Avid MediaDrive rS250, Avid MediaDrive 
rS80, and DigiDrive FireWire 80. Performance with other drives may vary. 
 

Drive 
Count 

44.1/48 kHz 
no Chassis 

44.1/48 kHz 
with Chassis 

96 kHz 
192 kHz 

no Chassis 
192 kHz 

with Chassis 
6 192 160 96 36 30 
4 128 128 64 24 16 
2 64 64 32 12 12 
1 32 32 16 6 6 
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External Audio Hard Drive Considerations 
 
If you are using a dedicated external audio hard drive, please review the 
notes below: 

• If you have no available FireWire ports on your computer, you can 
add a supported PCI or PCMCIA FireWire card to gain additional 
FireWire ports. For a list of supported cards, please visit our website 
at http://www.digidesign.com/support. 

• Laptops using FireWire audio interfaces with no option for additional 
PCMCIA (Cardbus) cards do not support recording audio with 
Pro Tools.  

• You can chain a supported FireWire interface to the secondary port 
on some FireWire 400 drives. If you experience FireWire- or drive-
based errors with this configuration, moving the peripherals to two 
separate FireWire busses on your computer may resolve your 
problem (see Appendix B). 

• Sometimes using FireWire 800 drives in conjunction with FireWire 
400 interfaces can cause errors. This is usually due to both FireWire 
ports sharing the same bus. Moving the interface to a secondary 
FireWire 400 bus can help (depending on your motherboard 
specifications). You can also try adding a PCI or PCMCIA FireWire 
card for connecting your FireWire hard drive (the card utilizes the 
PCI bus of the motherboard’s FireWire bus). 

• If you are using an Mbox 2 Pro or M-Audio FireWire interface, the 
use of FireWire 800 drives is not supported. Please only use 
FireWire 400 drives if you have one of these interfaces. 

 
FireWire Drives—Approximate Track Count 
 
The following test results are with Avid MediaDrive rS250, Avid MediaDrive 
rS80, and DigiDrive FireWire 80. Performance with other drives may vary. 
 
Drive Count 44.1/48 kHz 96 kHz 192 kHz 

1 24 12 6 
2 48 24 12 
3 72 36 18 
4 96 48 24 
5 120 60 30 
6 128 72 36 
8 192 96 36 
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Chapter 3 

Setting Up Your Interface 
 
The following section covers general information for setting up your 
Digidesign interface, and is divided between LE and HD product lines. 
Always refer to the Getting Started Guide that came with your Digidesign 
interface for installation and set-up procedures regarding your particular 
interface. For M-Audio devices, please refer to the M-Audio documentation 
that came with your M-Audio interface regarding installation and set-up. 
 
Note: In all cases, on Windows, the Found New Hardware Wizard should 
not be used to install drivers for your hardware. 
 

LE Hardware 
 
USB Interfaces include Mbox , Mbox 2 , Mbox 2 Mini , and M-Audio 

USB interfaces. All USB interfaces require an available USB port on the 
computer. Using USB hubs or chaining to another USB peripheral is not 
supported and can result in errors.  
 
Once you have plugged in the USB interface, the power LEDs on the 
interface may not light until the appropriate drivers are installed. The 
correct drivers are installed when you install Pro Tools. 
 
USB interfaces receive power directly from the USB bus (note that there is 
no power switch for Digidesign USB interfaces), so be sure the USB bus 
provides enough power for your interface. This is especially important 
when phantom power (+48V) is needed for condenser microphones. 
 
Note: Some laptops do not supply enough power for condenser 
microphones, and are not supported for use with phantom power. 
Supported laptops can be found by choosing your interface from the "Pro 
Tools LE" list in the Support section: http://www.digidesign.com/support. If 
you're using an Mbox 2 with a supported laptop and are having power 
issues, install the latest firmware revision (available on 7.0 and above 
installer disks and the website).  
 
In addition, some laptops require USB interfaces to be plugged into a 
specific USB port (full information can be found on the website) to resolve 
dropped samples, clicks and pops during playback, and constant buffer 
errors. 
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FireWire Interfaces include 003 , 003 Rack , Mbox 2 Pro , Digi 002 , 

Digi 002 Rack , and M-Audio FireWire interfaces. All FireWire interfaces 

require an available FireWire 400 port on the computer. Connecting 
interfaces to hubs, unsupported PCI or PCMCIA cards, or other FireWire 
peripherals is not supported and can result in errors.  
 
FireWire devices should never be hot-swapped (plugging in or unplugging 
the FireWire cable while there is power present). Be sure to turn off both 
the interface and computer before you connect or remove the FireWire 
cable.  
 
Once you have the interface plugged in, the computer may not recognize 
the interface until the appropriate drivers are installed. The correct drivers 
are installed with Pro Tools. 
 
While the 003 and Digi 002 series interfaces have a dedicated power 
supply, the Mbox 2 Pro can receive its power directly from the FireWire 
bus. However, when using with a laptop, the AC power adapter supplied 
with the Mbox 2 Pro should be used to power the interface.  
 
If you are using a dual-processor G5 computer, your interface should 
always be connected to the front FireWire port. On Mac Pro models, the 
interface should always be connected to the back FireWire port. 
 
Note: The second FireWire port on the back of FireWire audio interfaces is 
meant to supply power or communication to devices that are not being 
used when Pro Tools is running (such as digital cameras or portable MP3 
players). This port is not meant for sending and receiving data while Pro 
Tools is launched, and FireWire drives should be connected to a separate 
port on the computer (see Hard Drive Considerations). 
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HD Hardware 
 
HD Cards include Accel Core, HD Core, HD Accel, and HD Process cards. 
All HD cards require an available PCI or PCIe slot. For expanded systems 
or systems running on a laptop, a supported chassis is required and all 
cards must be in the chassis (for more information, see the Expanded 
Systems Guide).  
 
Before installing the cards, please refer to your Getting Started Guide for 
proper slot and card order, and interface connection. For systems with an 
expansion chassis, see the Expanded Systems Guide. 
 
HD Audio Interfaces (192 I/O , 192 Digital I/O , 96 I/O , 96i I/O ) 

require an available Accel Core, HD Core, HD Accel, HD Process, or 
Expansion port. Interfaces should follow the slot order of the HD Cards 
installed (the first interface connected to the Core Card, the second into 
the Expansion port (preferred) or next Accel or Process card, and so forth). 
Always refer to your Getting Started Guide for proper interface installation 
and set-up. 
 
Note: Connecting a second interface to the second card requires a 
dedicated DSP chip on that card, whereas connecting it to the Expansion 
port of the first interface uses the DSP chip already allocated on the first 
card. If DSP traffic errors occur in high track-count recordings, moving the 
second interface to the second card (rather than the expansion port) can 
help to alleviate these errors. 
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Chapter 4 

Installation and First Launch 
 
This chapter covers problems that can occur during installation, or the first 
time you launch Pro Tools. Remember, before installing Pro Tools, please 
follow the instructions in the Getting Started Guide regarding installing and 
configuring your Pro Tools system. 
 
This may also be a good time to back up your system to a restore point. 
There are several third-party applications that let you save a copy of your 
current operating system, such as Norton Ghost, Acronis TrueImage, and 
Carbon Copy Cloner. Please consult with your computer manufacturer or 
dealer for more information. 

 
Once your computer has been correctly configured and optimized, you can 
install Pro Tools. If Pro Tools has already been installed in your system 
and is launching without errors, you can skip this chapter. 
 

Installing or Upgrading Pro Tools 
 
When installing Pro Tools software on a new system, follow the 
instructions in the Getting Started Guide (either printed or PDF). When 
installing a Pro Tools update, follow the instructions in the Upgrading To 
Pro Tools Guide.  
 
Removing Previous Versions 
 
If this installation is an upgrade, or an older version of Pro Tools exists 
from another system, then all previous versions of Pro Tools should be 
removed before installing (unless otherwise stated in the documentation.) 
 
Not completely removing an older version of Pro Tools before you install 
your new version can cause severe errors in the operating system, such as 
Windows Registry or Mac Library corruption. These errors may be 
resolved by uninstalling all versions of Pro Tools (including the current 
version), but in worst-case scenarios you may need to reinitialize your 
operating system. 
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Removing Pro Tools on Windows XP 
 
To remove Pro Tools 7.1 and below on Windows XP: 

1. Choose the appropriate version in the Windows Add or Remove 
Programs list in the Control Panel.  

2. When prompted, choose the uninstall option that removes the most 
items (i.e., Digidesign Pro Tools, databases, drivers, etc.).  

3. Restart your computer when prompted. 
 
Removing Pro Tools on Mac OSX 
 
To remove Pro Tools 7.1.1 and above: 

1. Open the Mac HD/Applications/Digidesign/Pro Tools/Pro Tools 
Utilities folder. 

2. Run the Uninstall Pro Tools utility. 
3. When prompted, choose “Clean Uninstall.” 
4. When the uninstaller is finished, select “Quit.” 

 
To remove Pro Tools 7.1 and below:  

1. Run the regular installation off the disk or web installer and select 
"Uninstall" on the Custom Install page.  

2. When prompted, choose "Clean Uninstall."  
3. When the uninstaller is finished, select “Quit.” 

 

Installation Errors 
 
Software Installation Errors 
 
Pro Tools must be installed on the system drive for proper performance. If 
you have installed Pro Tools to a non-system drive (such as an external 
FireWire drive), follow the steps above to uninstall Pro Tools, and then 
install Pro Tools on the system drive. 
 
Always be sure to double-check that your version of Pro Tools is 
compatible with your operating system. Current compatibility information 
can be found on the Digidesign website Support section on this page: 
http://www.digidesign.com/index.cfm?navid=54&itemid=23954. 
 
Follow the steps outlined in the Getting Started or Upgrading To Pro Tools 
Guides for proper installation. 
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Driver Installation Errors 
 
Improper installation or driver conflicts can cause the installer to incorrectly 
install the drivers. If this has occurred, an error is displayed after 
installation or the first time you launch Pro Tools. 

• On Windows, these errors usually refer to the tpkd or dalwdm drivers 
(hardware drivers that Pro Tools needs in order to communicate with 
your interface). There may also be a generic Windows error 
message simply stating that the drivers may not have been installed 
properly, and that Pro Tools may be slow to run. 

• On Mac, the hardware interface may not be recognized by 
Pro Tools, or may not be fully functional.  

 
Interface Installation Errors 
 
If your interface is not recognized, be sure that you have correctly 
connected the device prior to launching the installer application (see 
Setting Up Your Interface). Also make sure that you have the proper 
version of Pro Tools installed for your device (please refer to the 
Digidesign website "Compatibility Information" page here: 
http://www.digidesign.com/index.cfm?navid=54&itemid=23954). 
 
Software, driver, and interface installation errors are commonly resolved by 
removing Pro Tools, optimizing your system, and then reinstalling the 
Pro Tools. However, in rare cases it may require that the operating system 
also be reinitialized. If you are using an unsupported system or 
configuration, these errors may indicate an incompatibility with your current 
setup. If necessary, please contact Digidesign Technical Support for 
troubleshooting if these errors persist. 
 

Launching Pro Tools 

 
Authorizing Plug-Ins and Software Options 
 
A common error can result from installing the extra plug-ins and options 
contained on the Pro Tools installation CD.  
 
Several ”for-purchase-only” plug-ins and options are included on all 
Pro Tools installer disks. Each of these has its own individual installer and 
requires an iLok USB Smart Key authorization in order to run. You can 
purchase these additional plug-ins and options separately. 
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Note: All plug-ins that are bundled free with Pro Tools are automatically 
installed by the Pro Tools installer application.  
 
Obtaining iLok Authorization 
 
If you do not have an iLok with the proper authorization for these additional 
plug-ins and options, you will not be able to use them unless you purchase 
the proper authorizations or request time-limited demo authorizations. To 
avoid the authorization prompt the next time you launch Pro Tools, you 
should remove the plug-in from your plug-ins folder  
 
If your iLok has the proper authorizations installed but is not authorizing 
the plug-ins, download the latest PACE InterLok (iLok) drivers at 
http://www.paceap.com/dldrvr.html. PACE is a separate company from 
Digidesign that develops anti-piracy software and hardware (iLok) for 
Digidesign and other companies. 
 
If your iLok is not lighting up or is physically damaged, contact PACE to set 
up a repair (RMA) through http://www.ilok.com. 
 
Removing Unauthorized Plug-ins 
 
Write down the name of each plug-in asking for authorization and follow 
the steps below. 
 
On Windows XP: 

• Remove each plug-in from the Add / Remove Programs Control 
Panel. DO NOT remove the Digidesign Shared Plug-Ins listing, as 
that will remove all plug-ins included with Pro Tools. 

 
—OR— 
 
1. Open My Computer\System Drive (C:)\Program Files\Common 

Files\Digidesign\DAE\Plug-ins. 
2. Find and delete each plug-in (either .dpm or .rsr) that is prompting 

you for authorization. DO NOT remove the entire folder, as all of 
your authorized and free plug-ins are located here as well. 

 
On Mac OSX: 

1. Open Macintosh HD/Library/Application Support/Digidesign/Plug-ins.  
2. Find and delete each plug-in that is prompting you for authorization. 

DO NOT remove the entire folder, as all of your authorized and free 
plug-ins are located here as well. 
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Removing Other Paid Software Options 
 
If you installed any unauthorized Pro Tools options (such as Music 
Production Toolkit , DV Toolkit 2 , or DigiTranslator  2.0), they too will 

prompt you for an authorization when you launch Pro Tools. To remove 
any unauthorized options, follow the steps below. 
 
On Windows XP: 

1. Open My Computer\System Drive (C:)\Program 
Files\Digidesign\Pro Tools.  

2. Delete the dll for the option that is prompting you for an 
authorization: MusicProductionToolkit.dll, DVToolkit2.dll, 
Timecode.dll, or OMF.dll. 

 
On Mac OSX: 

1. Open Macintosh HD/Applications/Digidesign/Pro Tools. 
2. Delete the bundle for the option that is prompting you for an 

authorization: MusicProductionToolkit.bundle, DVToolkit2.bundle, 
Timecode.bundle, or OMF.bundle. 

 
Authorizing Pro Tools 
 
Pro Tools will begin to load as soon as you launch the application. It may 
take a few seconds for the Pro Tools logo screen to appear on the first 
launch while the application builds its database and preference files.  
 
Also on the first launch, you will be asked for your Authorization Code. The 
location of your Authorization Code depends on how you purchased your 
system or software upgrade, as follows: 

• On the front inside cover of the Getting Started Guide if your version 
of Pro Tools came with your interface or HD purchase (or on the 
back of the Pro Tools DVD sleeve for some Mbox 2 Mini purchases). 

• In the Upgrading To Pro Tools Guide if you purchased a Pro Tools 
version update at a retailer. 

• On your receipt in your DigiStore account if you purchased Pro Tools 
on the DigiStore. 

• In the amnesty update e-mail if you received a Pro Tools update via 
e-mail following registration. 

 



Page 18 

For systems that shipped with more than one version, be sure that you are 
entering the correct Authorization Code. The sticker indicates which 
version its code is for, and the first eight numbers and letters should be 
similar to the version you're installing (for example, for Pro Tools 6.9, the 
code begins with DIGI0690 and for Pro Tools 7, the code begins with 
DIGI0700). 
 
Please note: your Authorization Code should be typed exactly as it 
appears on the sticker—it is both cAsE and s p a c e sensitive, and the 
letter o is not used, only the number 0. 
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Chapter 5 

 

Operational Errors 
 
This chapter covers operational errors. For example, errors during launch, 
unexpected quits, and session corruption will all be discussed. 
 

Pro Tools Fails To Launch 
 
Assertion and Neo Access Errors 
 
If you encounter an Assertion Error—an error with a long file path after it, 
and ending in a “Line” with a numerical value, you will need to delete your 
databases, preferences, and volumes. This error is likely related to 
improper maintenance and unmounting of external hard drives.  
 
If you have external hard drives connected to your system, you must 
always properly unmount them before turning them off or removing them 
from the system, and before shutting your system down. By not properly 
doing so, Pro Tools database and preference files can become corrupted, 
resulting in these (and other) errors. You also run the risk of corrupting the 
Root Directory of those drives, which can result in drive failure and even 
data loss. 
 
Deleting databases, preferences, and volumes can resolve other issues as 
well, such as I/O Setup issues, graphic or display problems, and other 
intermittent errors that are not specifically hardware or compatibility 
related.  
 
Deleting Digidesign Databases (Windows XP and Mac) 
 
These folders are found on the root (first) level of all installed hard drives. 
You should delete all of these folders.  
 
Note: Pro Tools sessions and audio files should NEVER be stored in these 
folders. Be sure to quit Pro Tools prior to deleting these folders. 
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Once you have deleted the Digidesign Databases, empty the Recycle Bin 
or Trash Can and restart your computer. These files will be recreated the 
next time you launch Pro Tools. Pro Tools may appear slow to launch 
immediately after these files are deleted, because it has to write new 
Digidesign Database files. 
 
Deleting Preferences and Volumes on Windows XP 
 
DAE Preferences: 

1. Open My Computer\System Drive (C:)\Program Files\Common 
Files\Digidesign\DAE\DAE Prefs.  

2. Open the DAE Prefs folder and delete all of its contents. 
 
Pro Tools Preferences: 

1. Open My Computer\System Drive (C:)\Documents and 
Settings\User*\Application Data**\Digidesign. 

2. Open the Digidesign folder and delete all of its contents. 
 

* This is the Windows user account with which you log in when using 
Pro Tools. 
** This folder is hidden by default. To view hidden files and folders, 
open the Tools menu in the folder view window and choose Folder 
Options. In the View tab, click the option to "Show hidden files and 
folders." 

 
Volumes: 

1. Open My Computer\System Drive (C:)\Program 
Files\Digidesign\Pro Tools\Databases.  

2. Inside the Databases folder, delete the Volumes folder. 
 
Once you have deleted the Pro Tools preferences and volumes, empty the 
Recycle Bin and restart your computer. These files will be recreated the 
next time you launch Pro Tools. Pro Tools may appear slow to launch 
immediately after these files are deleted, as the application has to write 
them again. 
 
Note: You may have to reconfigure your Preferences, I/O Setup, and MIDI 
Setup in Pro Tools after these files have been deleted. 
  



Page 21 

Deleting Preferences and Volumes on Mac 
 
Volumes: 

1. Open Macintosh HD/Library/Application 
Support/Digidesign/Databases. 

2. Open the Volumes folder and delete all of its contents. 
 
Pro Tools Preferences: 

1. Open Macintosh/Users/Username*/Library/Preferences.  
2. Delete the following items: 

• com.digidesign.protools.plist 
• DAE Prefs folder 
• DigiSetup.OSX 
• Pro Tools Preferences 

 
* This is the Mac user account with which you log in when using Pro Tools. 
 
Once you have deleted the preferences and volumes files, empty the 
Trash and restart your computer. These files are recreated the next time 
you launch Pro Tools. Pro Tools may appear slow to launch immediately 
after these files are deleted, as the application has to write them again. 
 
Note: You may have to reconfigure your Preferences, I/O Setup, and MIDI 
Setup in Pro Tools after these files have been deleted. 
 

Pro Tools Quits Unexpectedly 
 
If the Pro Tools application fails to launch or quits unexpectedly (Mac), or 
presents a Fatal Exception Error or "blue-screen" (Windows), or simply 
quits without reporting an error, you may need to uninstall and re-install 
Pro Tools (be sure to properly remove all previous versions as well). These 
errors can also be related to improper interface connections (see Setting 
Up Your Interface), or a possible system incompatibility.  
 
Make sure you have correctly installed Pro Tools on a supported system. 
Windows users should check their chipset for compatibility. Mac users 
should check their version of Mac OS X for compatibility with the installed 
Pro Tools system. Current compatibility information can be found on the 
Digidesign website "Compatibility Information" page: 
http://www.digidesign.com/index.cfm?navid=54&itemid=23954 
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Pro Tools Session Fails to Open 
 
If Pro Tools launches successfully, but you are unable to create or open a 
session due to the following error, “X: (your hard drive) could not be 
designated as an Audio Record Volume,” and if you cannot change the 
drive in the Workspace browser, you may need to delete your databases 
and preferences. For more information, see Deleting Digidesign Databases 
(Windows XP and Mac).  
 
Sometimes a session or affiliated file can become corrupt. If deleting the 
databases and preferences does not solve an issue when opening a 
session, then try to create a copy of the session instead.  
 
To do this, simply use the File > Save Copy In (or “Save Session Copy In” 
in older versions) to save a copy of the session and all audio files (be 
sure to check the All Audio Files box in the dialog box). Copying all fade 
files is unnecessary, and this option should be left unchecked if possible. 
Pro Tools maintains an index of each fade in the session file itself, and 
rebuilding these fades may help resolve any session corruption. 
 
Incompatible plug-ins can also have an adverse effect on your sessions. 
Be sure to check the compatibility of all third-party plug-ins installed on 
your system through the individual plug-in manufacturer. Check for 
operating system, platform, and Pro Tools compatibility and update 
accordingly. You can also try moving all third-party plug-ins from the Plug-
ins folder in order to determine whether or not the problem is due to an 
incompatible plug-in. 
 
On Windows XP: 

1. Open the My Computer\C:\Program Files\Common 
Files\Digidesign\DAE\Plug-ins folder. 

2. Move all third-party plug-ins to the My Computer\C:\Program 
Files\Common Files\Digidesign\DAE\Plug-ins (Unused) folder. 

 
On Mac: 

1. Open the Mac HD/Library/Application Support/Plug-ins folder. 
2. Move all third-party plug-ins to the Mac HD/Library/Application 

Support/Plug-ins (Unused) folder 
 
If the problem persists, you can move your plug-ins back to the original 
Plug-ins folder. If the problem goes away, you can determine the 
problematic plug-ins by moving back half of the plug-ins and launching Pro 
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Tools again. Repeat this process until you can no longer successfully open 
a session. 
 
Note: If your version of Pro Tools is incompatible with your computer’s 
operating system, you may experience a variety of errors, including the 
computer rebooting unexpectedly, the audio interface not being 
recognized, or the inability to designate a drive as an Audio Record 
Volume. For information on what version of Pro Tools is required for your 
computer’s operating system, please see the "Compatibility Information" 
web page: http://www.digidesign.com/index.cfm?navid=54&itemid=23954. 
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Appendix A 

About the Digidesign Audio Engine (DAE) 
 
H/W Buffer 
 
DAE acts like a translator and manager for Pro Tools tasks, which include 
reading and writing automation, RTAS  processing, voice allocation, and 

graphic redraws. In general, the H/W Buffer is like a "traffic cop" for these 
tasks, and controls the buffer time, in samples, given for them to process. 
For instance, if the H/W Buffer Size is set to 512 samples (in the Playback 
Engine dialog) at a sample rate of 44100 (samples per second), then the 
buffer is effectively 12 milliseconds (see the formula below). 
 
 1 Second 
----------------- X H/W Buffer Size (samples) = H/W Buffer Size (milliseconds) 
Sample Rate 
 
In this example, every 12 milliseconds the buffer is being filled (like filling a 
bucket with water) with various information; such as audio for RTAS plug-
in processing, graphics redraws, and automation handling. RTAS 
processing takes priority of these tasks, and both the data to be sent to the 
plug-in, as well as the returned and affected audio, are stored in the buffer 
for that 12 milliseconds. At the end of the buffer period, the results of all 
the information that was sent out is read by DAE.  
 
Pro Tools|HD systems process I/O, the software mixer, and other Pro 
Tools operation processing on dedicated DSP chips on Pro Tools HD 
cards. For Pro Tools LE systems, these processes are using the same 
buffer period as RTAS processing, and the host CPU is running more 
calculations to complete these tasks in the given buffer period: this is why 
the H/W Buffer Size directly affects latency in LE systems. A general rule 
of thumb for best performance with Pro Tools LE, deactivate any 
unnecessary plug-ins when recording and set the H/W Buffer Size in the 
Playback Engine dialog as low as possible (until you run into DAE errors). 
When monitoring a live input is not required, the H/W Buffer Size can be 
increased in the Playback Engine dialog and any deactivated plug-ins can 
be reactivated. 
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DAE Errors 
 
So what happens if the buffer time allotted is not enough to complete the 
processing? That is when DAE will start to report buffer errors. Since there 
is not enough time to complete the needed processing, DAE has two 
options: it either ignores the error or it stops the transport and reports the 
error. Under normal operation, there is no margin of tolerance, and buffer 
errors appear even if there is a single dropped sample (more on this later). 
If the RTAS Error Suppression option is enabled in the Pro Tools Playback 
Engine dialog, then this margin is widened (but at the risk of compromising 
audio quality!). 
 
CPU Usage 
 
The CPU Usage Limit (set in the Playback Engine dialog) determines the 
percent of overall buffer time (per processor) that can be used for RTAS 
processing. So, if we set the CPU usage limit to 85%, then 10.2 
milliseconds (85% of 12 ms) is the total allowable time for processing to 
take place and the remaining 1.8 ms is dedicated to other processing 
tasks. Once the 12 ms buffer period has ended, if the time allotted was not 
enough for the all the processing tasks, the results are sent to DAE, which 
stops playback and reports a buffer error (–9128) prompting you to 
increase the Buffer Size or the CPU Usage Limit. If all RTAS processing 
took less than 10.2 ms, then the audio is passed to DAE for playback and 
the buffer is cleared and refilled for another round. 
 
RTAS Processing 
 
For some single-processor systems with FireWire interfaces, there is an 
option to increase the CPU usage limit to 99%. While this may help RTAS 
processing, it may result in another error. If the RTAS processing is using 
almost all the available buffer (11.88 ms, in this case), then that leaves 
less than a millisecond for all other tasks to complete their processing. For 
FireWire drivers, this can result in constant –6097 errors and loss of 
communication with the interface. For single-processor computers, it's best 
to try alleviating some of the RTAS processing (by deactivating some 
RTAS plug-ins or using AudioSuite  where appropriate) and set the CPU 

usage limit to something more manageable. For multi-processor 
computers, you may achieve better performance by setting the number of 
processors to 1, instead of 2 (or 3, instead of 4). This dedicates the 
number of selected processors entirely to RTAS processing while freeing 
the other available processors to run other tasks, such as system 
operation. 
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If you are noticing issues related to timing when recording or playing back 
MIDI, late mute and plug-in automation, slow graphic redraws, or 
monitoring latency, setting the H/W Buffer Size to a lower sample size can 
help alleviate those timing issues at the cost of RTAS plug-in count. If you 
are noticing these errors in addition to –9128 errors, changing the CPU 
Usage limit should decrease the DAE errors, but not affect session 
performance and latency. As always, it is all about balance—you may 
need to experiment to find the happy medium where all your current 
session needs are met. 
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Appendix B 

Common DAE Errors and What They Mean 
 
This section of the guide is a compilation of the most common DAE errors, 
by related category and error number. We have provided some Quick Tips 
to help you troubleshoot these errors, but this is assuming you've already 
completed the related optimizations for your computer from the Getting 
Started Guide. 
 
Automation 
 

• –9155 ("Automation is too dense. Try thinning automation data.") 
 
Quick Tips:  

• If you have a computer with multiple processors, set the RTAS 
Processors option in the Playback Engine dialog to fewer than the 
total number of available processors (this may decrease RTAS 
performance). 

• Try Thinning Automation data, especially if automation was written 
using a control surface (fader movements create many more break-
points than mouse-drawn automation).  

• If you have all Plug-in automation enabled by default, try turning this 
option off and only enable those parameters you need to automate. 

 
Bounce To Disk 
 

• –9131 ("Bounce Handler can't keep up with audio from disk" when 
selecting Convert After Bounce)\ 

• –9132 ("Bounce Handler can't keep up with audio from disk" when 
selecting Convert After Bounce) 

• –9133 ("Bounce Handler can't keep up with audio from disk" when 
selecting Convert During Bounce) 

• –9139 ("Bounce Handler can't keep up with audio from disk" when 
selecting Convert During Bounce) 

 
Quick Tips:  

• Try Bouncing to a different hard drive, select Convert After Bounce, 
Consolidate Regions with multiple edits, and record disk-based 
effects and instruments to their own audio track instead of streaming 
from the disk.  
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• Consider allocating audio source files to separate hard drives (if 
available) in large track-count sessions (see Hard Drive Recording 
Information).  

• Thinning automation on automation-heavy sessions may also help 
avoid these errors.  

• Try closing any open windows (including open windows in other 
applications) before bouncing to save a little extra processing 
required by the graphics card, especially for laptops. 

 
Disk Related 
 

• –9019 ("DAE is having trouble keeping up, disk may be too slow or 
fragmented.") 

• –9073 ("DAE can't get audio from the disk fast enough. Your disk 
may be too slow or fragmented. A FireWire disk could be having 
trouble due to the extra FireWire bandwidth or CPU load.") 

• –9093 ("DAE is unable to complete this operation. The disk may 
either be too slow or too fragmented.") 

 
Quick Tips:  

• If you are recording to your internal drive, try moving your session 
and all audio files to a dedicated audio drive. USB drives are not 
supported at the time of this writing. If you are using an external 
drive, make sure that it meets the required drive specifications (for 
more information, see Hard Drive Considerations). 

• If your hard drive is full or has not been defragmented recently, 
defragment it. You may also want to back it up onto a fresh drive or 
partition to secure your data (this will also defragment the data). 

• Drives that exceed 200 GB should be partitioned into multiple 
volumes. If your session is streaming audio from multiple partitions 
of a single physical drive, the source files should be consolidated 
onto a single partition or across multiple physical drives.  

• If you are chaining your interface to your drive or vice versa, move 
one or the other to their own dedicated FireWire bus. If an additional 
FireWire bus is not available, consider adding more using a PCI 
FireWire card (for a current list of supported PCI FireWire cards, 
please check the compatibility information for your Pro Tools system 
on the website at http://www.digidesign.com/support). 
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FireWire Interface / Driver Specific 
 

• –6006 ("DAE error 6006 was encountered.") 
• –6085 ("Audio device buffer underflowed. If this occurs frequently 

please try increasing the H/W Buffer Size in the Playback Engine 
Panel or remove other devices from audio FireWire bus.")  

• –6093 ("The operating system held off interrupts for too long. If this 
occurs frequently, try increasing the "H/W Buffer Size" in the 
Playback Engine panel.") 

 
Quick Tips:  

• FireWire communication requires an uninterrupted connection using 
the FireWire driver. Sometimes using unsupported FireWire PCI 
cards or chaining the interface to another FireWire device can cause 
a halt in communication. Ensure that your interface is connected 
directly to a built-in port on the motherboard of your computer or a 
supported PCI card, and disconnect all other FireWire peripherals.  

• If you have a FireWire hard drive with a supported Oxford 911, 912, 
or 924 chipset, then you can successfully chain your interface to the 
secondary FireWire port of the drive (if available). Please note that it 
is recommended to connect both devices to their own FireWire bus 
on the motherboard of the computer, if possible.  

• Disabling devices like Airport and Bluetooth, as well as all Network 
Adapters, can free up processing needed for FireWire 
communication.  

• Under no circumstances should you use a FireWire hub or 
secondary connection (such as the Apple Cinema Display) to 
connect your FireWire interface.  

• In addition, disabling background services and applications can help.  
• If you have a dual-processor computer, then free up one (or more) of 

the processors for FireWire processing in the Playback Engine (this 
may limit your RTAS performance).  

• If you are using Pro Tools M-Powered, be sure that you have the 
latest drivers for your FireWire device (visit http://www.m-audio.com 
and go to the Support > Drivers and Updates section for downloads). 
You can run most M-Audio interfaces from the power supplied via 
the FireWire bus. Try removing the supplied power adapter from 
your interface, if connected (unless using a laptop). 
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USB Interface/Driver Specific: 
 

• –9136 ("CPU usage is holding off USB audio. Remove some plug-
ins, delete some tracks, or increase the "H/W Buffer Size" in the 
Playback Engine dialog.") 

 
Quick Tips:  

• A must for any Windows PC is to check your chipset. You can do 
this by installing the program PC Wizard (included on more recent 
Pro Tools installation disks or available on the web at 
http://www.cpuid.org/pcwizard.php. The chipset of a computer 
handles information from the USB bus to the processor (as well as 
other tasks) and can potentially cause major errors if incompatible. 
Compare your chipset against those we list specifically as tested on 
our website at http://www.digidesign.com/support. If your chipset is 
not listed, then USB performance cannot be guaranteed.  

• In addition, make sure you are not chaining your interface to a hub 
or other USB peripheral, as all devices need to be connected directly 
to the computer's built-in USB port.  

• On certain laptops (both Mac and PC), only one USB port is qualified 
for use with USB interfaces - make sure you check our website for 
specific information on a supported system.  

• Configure the power settings on your computer. On Windows XP 
computers, be sure your Power Management scheme is set to 
“Always On.” On Mac, set your Energy Saver options for Computer 
and Display Sleep to “Never” and uncheck “Put the Hard Disk(s) to 
sleep when possible.” 

• On Windows XP, try disabling Power Management of the USB Root 
Hub. To do this, open the Device Manager and expand the Universal 
Serial Bus controllers list. Right-click on the first USB Root Hub and 
select Properties. Under the Power Management tab, uncheck the 
box for “Allow the computer to turn off this device to save power.” 
Repeat this step for all listed USB Root Hubs. 

• Sometimes other USB peripherals can cause interrupts in USB 
traffic to and from the interface. Remove all such devices except the 
mouse and keyboard. This includes wireless devices, USB modems, 
and hubs. If performance does not improve, make sure that devices 
like Airport and Bluetooth and any Network Adapter have been 
disabled.  

• Under no circumstances should you use a USB hub or secondary 
connection (such as the Apple Cinema Display) to connect your USB 
interface. 



Page 31 

RAM Related 
 

• –9006 ("The plug-in could not be made active because a DAE error 
was encountered") 

 
Quick Tips:  

• Install more RAM into your system.  
• Try "printing" (bus recording) any instrument plug-in to an audio 

track, then disable the plug-in.  
• Deactivate RTAS plug-ins. If you wish to keep the RTAS effect on an 

audio track without sacrificing CPU usage, you can use AudioSuite 
plug-ins with duplicate Playlists. To do this, copy the parameters of 
your RTAS plug-in and duplicate the current Playlist. Deactivate the 
plug-in (Command-Control-click for Mac or Control-Start-click for 
Windows on the plug-in name in the insert). Paste the settings to the 
AudioSuite version of that plug-in (when available) to process the 
effect down to the duplicate Playlist. If you need to edit the effect 
later, you can simply switch back to the original Playlist and 
reactivate the RTAS plug-in. 

 
RTAS Processing 
 

• –6031 ("You are running out of CPU power. Remove some RTAS 
Plug-ins or decrease the CPU Usage Limit in the Playback Engine 
Dialog.") 

• –9128 ("You are running out of CPU power. Remove some RTAS 
Plug-ins or increase the CPU Usage Limit in the Playback Engine 
Dialog.") 

 
Quick Tips:  

• Try increasing the H/W Buffer Size in the Playback Engine dialog to 
allow more time for RTAS processing. 

• Make sure no other applications or background services are using 
valuable CPU cycles.  

• Consolidate multiple effects, such as reverbs, to a dedicated bus 
and Auxiliary Input track, and bypass plug-in settings that are not 
being used (such as EQ bands).  

• If you wish to keep the effect on an audio track without sacrificing 
CPU usage, follow the steps below: 

• Deactivate RTAS plug-ins. You use the method described above to 
process the effect to an audio track without sacrificing CPU usage. 
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